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Upgrading to Cisco Unified Contact Center 
Express, Release 8.0(2)

For Cisco Unified Contact Center Express and Cisco Unified IP IVR
Releases 8.0(2)

This document describes how to upgrade to Cisco Unified Contact Center Express 
(Unified CCX), Release 8.0(2) from the 5.0(2) and 7.0(1) releases. For more 
information on tested upgrade paths, refer to the Software and Hardware 
Compatibility Guide for Cisco Unified CCX and Cisco Unified IP IVR available 
here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device_su
pport_tables_list.html

For information about performing a fresh installation of Unified CCX (rather than 
upgrading from an earlier release) or configuring Unified CCX when it is 
pre-installed on your server, see the Installation Guide for Cisco Unified CCX and 

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device_support_tables_list.html

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device_support_tables_list.html
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Cisco Unified IP IVR available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_gu
ides_list.html

Before upgrading to Unified CCX 8.0(2), review all component upgrade 
instructions carefully.
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This document contains the following topics:

• Overview, page 2

• Intended Audience, page 3

• Related Documentation, page 3

• Important Considerations, page 4

• Upgrading to Unified CCX 8.0(2), page 7

• Obtain Additional Support and Documentation, page 26

• Documentation Feedback, page 26

Overview
Unified CCX 8.0(2) offers a direct solution for Cisco Customer Response 
Solutions (CRS) 5.0(2) and Unified CCX 7.0(1) to upgrade to Unified CCX 
8.0(2). 

The upgrade process from CRS 5.0(2) or Unified CCX 7.0(1) to Unified CCX 
8.0(2) is carried out in the following three phases:

• Backup phase

• Installation phase

• Restore phase

This document provides the necessary instructions and related information for 
upgrading all compatible releases (including SR and ES releases) of CRS 5.0(2) 
and Unified CCX 7.0(1) to Unified CCX, Release 8.0(2).

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_guides_list.html
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  Intended Audience

To view or verify the compatibility information for your server, see the Software 
and Hardware Compatibility Guide for Cisco Unified CCX and Cisco Unified IP 
IVR available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device_su
pport_tables_list.html

Note If you are running other releases of CRS, such as 4.0(5) or 4.5, you should 
upgrade your system to CRS 5.0(2) or Unified CCX 7.0(1), and then use this 
document to directly upgrade to Unified CCX, Release 8.0(2). 
For more information on how to upgrade to Unified CCX 7.0(1), see the 
Installation Guide for Cisco Unified CCX and Cisco Unified IP IVR, Release 
7.0(1) and Cisco Unified CCX Data Migration Tool User Guide, Release 1.0. 
For other releases, refer to the white paper available here:
http://www.cisco.com/en/US/prod/collateral/voicesw/custcosw/ps5693/ps1846/
white_paper_c11-452619-00.pdf

Note If you are already running Unified CCX 8.0(1), you can upgrade to Unified CCX 
8.0(2). For more information on how to upgrade from Unified CCX 8.0(1) to 
8.0(2), see the Release Notes for Cisco Unified CCX and Cisco Unified IP IVR, 
Release 8.0(2) available here: 
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_release_notes_
list.html

Intended Audience
This guide is intended for Cisco Unified Communications system administrators. 
You must have the network and telephony knowledge that is required to install, 
upgrade, and set up the Unified CCX software. You must also be familiar with the 
Cisco Unified Communications Manager (Unified CM) or Cisco Unified 
Communications Manager Express (Unified CME) configurations at your site.

Related Documentation
For additional installation-related information, see the following documents:

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device_support_tables_list.html

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device_support_tables_list.html

http://www.cisco.com/en/US/docs/voice_ip_comm/cust_contact/contact_center/crs/express_7_0/installation/guide/uccx70ig.pdf
http://www.cisco.com/en/US/docs/voice_ip_comm/cust_contact/contact_center/crs/express_7_0/installation/guide/uccx70ig.pdf
http://www.cisco.com/web/software/282467017/23664/UCCX_DataMigrationTool_Guide_405x-701.pdf
http://www.cisco.com/en/US/prod/collateral/voicesw/custcosw/ps5693/ps1846/white_paper_c11-452619-00.pdf
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_release_notes_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_release_notes_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_release_notes_list.html
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• Installation Guide for Cisco Unified CCX and Cisco Unified IP IVR
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installatio
n_guides_list.html

• Administration Guide for Cisco Unified CCX and Cisco Unified IP IVR
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_install
ation_and_configuration_guides_list.html

• Software and Hardware Compatibility Guide for Cisco Unified CCX and 
Cisco Unified IP IVR
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device
_support_tables_list.html

• For a list of troubleshooting tips related to Windows to Linux upgrade, see the 
following URL:
http://docwiki.cisco.com/wiki/Troubleshooting_Unified_Contact_Center_E
xpress

• For a complete list of terms used in Cisco Unified CCX and Cisco Unified IP 
IVR, see the following URL:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_technical_
reference_list.html 

For further information about Unified CCX documentation, see the following 
URL:

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products_suppo
rt_series_home.html

Important Considerations
Before you start upgrading your CRS or Unified CCX system, make sure you have 
met the following requirements:

• Ensure that you connect each Unified CCX node to an uninterruptible power 
supply (UPS) to provide backup power and protect your system.

Caution Failure to connect the Unified CCX nodes to a UPS may result in damage to 
physical media and require a new installation of Unified CCX.

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_technical_reference_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_technical_reference_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_installation_and_configuration_guides_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device_support_tables_list.html

http://docwiki.cisco.com/wiki/Troubleshooting_Unified_Contact_Center_Express
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_guides_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products_support_series_home.html
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• Use Backup and Restore system to take the regular backup of the CRS 5.0(2) 
or Unified CCX 7.0(1) server before you start the backup process using the 
Cisco Unified CCX Pre-Upgrade Tool (PUT).

• Make sure that all the nodes in the CRS 5.0(2) or Unified CCX 7.0(1) cluster 
are up and running before you start the backup process using the PUT.

• Stop and disable Cisco Security Agent (CSA) and other antivirus software 
applications, if any, running on the CRS 5.0(2) or Unified CCX 7.0(1) nodes 
in the cluster before starting the Windows to Linux Upgrade.

• You can continue to have your Call center operational while PUT is being 
installed. However, if the call center is operational during the backup 
operation, you might lose newly-generated call record data.

• Make sure that Unified CCX and Unified CM data are in sync before 
proceeding with the backup. If not please perform the data resync operation.

Note Configuration changes done through Cisco Unified CCX Administration after 
Unified CM “Linux to Linux Upgrade” installation and before “Linux to Linux 
Switch version” may not be migrated as part of the upgrade operation.

• You should always run PUT on the engine master node of the CRS/Unified 
CCX server.

• Be aware that your call center remains down during the upgrade process.

• PUT backs up only 1.5 GB of latest recording data per node.

• PUT does not back up any user level files (prompts /grammar/documents) that 
are stored outside of Unified CCX repository. You have to manually back up 
these files and keep it in a safe network location.

• You must disable the Proxy setting on the server on which you intend to run 
the backup activity. Otherwise, you might get the following error message: 

Proxy settings are enabled on this server. Turn off all the proxy 
settings prior to starting the backup operation.

• Perform the upgrade activity during off-peak hours or a maintenance window 
to avoid impact from call-processing interruptions. 

• You must have access to a secure FTP (SFTP) server to back up the data over 
a network.
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• Preferably use a SFTP server product that is certified with Cisco through the 
Cisco Technology Developer Partner program (CTDP), such as GlobalScape. 
However, Cisco allows you to use any SFTP server product.

• If you make any configuration changes during or after running PUT, the 
system does not retain these changes when you upgrade. 

• Be aware that when you install Unified CCX 8.0(2) on an existing server, the 
hard drive gets formatted, and all existing data on the drive gets overwritten.

• Procure the necessary Unified CM license(s) and keep them handy.

• After running the PUT and before installing Unified CCX 8.0(2), you must 
upgrade the system running Unified CM to the latest compatible version 
using “Linux to Linux Upgrade” process and reboot the system to switch to 
and activate the upgraded partition.

• Make sure to complete the installation of Cisco Unified CCX 8.0(2) software 
on the first node before installing the second node.

• Use the same security password on both the servers in the cluster if you plan 
for an HA setup after the upgrade.

• Be aware that all user credentials that you enter while running the installation 
wizard are case-sensitive. 

• Carefully read the instructions that follow before you proceed with installing 
Unified CCX 8.0(2). 

• Procure all the necessary Unified CCX 8.0(2) licenses and keep them handy 
after installing Unified CCX 8.0(2) server and before restoring the backed up 
data on the Unified CCX 8.0(2) system. For more information on how to 
procure the licenses, see the Installation Guide for Cisco Unified CCX and 
Cisco Unified IP IVR available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installatio
n_guides_list.html

• Before you install the second (subscriber) node, you must first add and 
configure it on the first (publisher) node using the first node’s Web 
Administration.

• Be aware that the demo license feature is not available when you upgrade 
from a previous product version.

http://www.globalscape.com/gsftps/cisco.aspx
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_guides_list.html
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  Upgrading to Unified CCX 8.0(2)

• After you successfully restore the backed up data on the first node, you must 
perform the JTAPI and Data Resync activity using the web interface of the 
Unified CCX Administration. This activity should be performed before you 
proceed with the Add to cluster operation. 

• For a two-node setup, both the nodes in the cluster must be running the same 
release / version of Unified CCX to perform the upgrade successfully.

• Installing the second node and then adding it to the cluster must be done 
during off peak hours to avoid possible call drops during the formation of a 
cluster.

• Perform the Add to Cluster operation only after you have completely restored 
and upgraded the first node in a two-node setup.

• Delete the migrated Cisco Tool for Auto-Registered Phone Support (TAPS) 
component from the recently upgraded Unified CCX 8.0(2) server to avoid 
data conflicts. After a successful upgrade, you must download the TAPS from 
the upgraded Unified CM server again and re-upload this component to the 
Unified CCX 8.0(2) server.

• For Unified CCX 8.0(x), prompt file names are case-senstive. Ensure that the 
prompt file names in the system exactly match the prompt file names used in 
scripts. You can complete this task before or after the upgrade. You can 
update the names in the scripts or in the system.

Upgrading to Unified CCX 8.0(2)
This section describes how to prepare for upgrade and perform the entire upgrade 
process on CRS 5.0(2) or Unified CCX 7.0(1) servers in order to move to Unified 
CCX, Release 8.0(2). As stated earlier, the entire upgrade process is carried out 
in following four phases:

• Backup Phase, page 8

• Installation Phase, page 19

• Restore Phase, page 20
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Backup Phase
In the backup phase, you back up your CRS or Unified CCX cluster with a tool 
offered by Cisco, called the Pre-Upgrade Tool (PUT). This tool facilitates the 
process of backing up data from your CRS or Unified CCX cluster. 

Since CRS 5.0(2) and Unified CCX 7.0(1) only support multi-node clusters with 
high availability (HA), you should run PUT on the engine master node. However, 
before you run PUT to complete the backup operation in an HA setup, make sure 
that both the nodes in the cluster are up and accessible. PUT retrieves the backed 
up data from the standby servers programmatically and move the complete backup 
TAR file to the SFTP location provided by you.

Note It is important that you back up the Unified CM data before you run the PUT as 
this may help you retrieve the Unified CM data in case you want to roll back to 
your existing setup of CRS 5.0(2) or Unified CCX 7.0(1). 

The following sub-sections explain more about the PUT and its functionality.

Overview of PUT

You can use PUT (CiscoUnifiedCCXPreUpgradeToolInstaller.exe) to back up 
data for Unified CCX, as specified in the following sections. PUT assists you with 
the first step in migrating CRS or Unified CCX data from the supported versions 
of 5.0(2) and 7.0(1) to Unified CCX 8.0(2) by exporting this data and saving it in 
a tape archive (TAR) file in a location that you specify. PUT also generates a log 
file, which you can view for detailed information on data backup. 

You must install and run PUT on the CRS 5.0(2) or Unified CCX 7.0(1) engine 
master node (in cases of multi-node cluster or high availability) before you 
upgrade to Unified CCX 8.0(2).

Note If you make any configuration changes during or after running PUT, the system 
does not retain any of these changes after the upgrade. 
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Obtaining and Installing PUT

PUT software is available for download from the following link: 
http://www.cisco.com/cisco/software/release.html?mdfid=270569179&softwarei
d=282988762. To install the PUT software on your CRS or Unified CCX system, 
complete the following steps: 

Step 1 Download and Copy the PUT installer 
(CiscoUnifiedCCXPreUpgradeToolInstaller.exe) to the CRS 5.0(2) or Unified 
CCX 7.0(1) engine master node.

Step 2 Double-click CiscoUnifiedCCXPreUpgradeToolInstaller.exe on the CRS 
5.0(2) or Unified CCX 7.0(1) engine master node. The Introduction screen 
appears (see Figure 1).

Note Download the PUT installer that corresponds to the version to which you 
are upgrading unified CCX. If you are upgrading to Unified CCX 8.0(2), 
Cisco recommendeds that you upgrade directly to Version 8.0(2) SU2 or 
later, using the corresponding PUT installer.

To quit the setup at any point of time during the installation, click Cancel.

Figure 1 Introduction Screen

http://www.cisco.com/cisco/software/release.html?mdfid=270569179&softwareid=282988762
http://www.cisco.com/cisco/software/release.html?mdfid=270569179&softwareid=282988762
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Step 3 Click Next. The Pre-Installation Summary screen appears (see Figure 2).

Figure 2 Pre-Installation Summary Screen

Step 4 Click Install. The Installing Cisco Unified CCX Pre-Upgrade Tool screen appears 
(see Figure 3).
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Figure 3 Installing Cisco Unified CCX Pre-Upgrade Tool Screen

Step 5 Once the installation is complete, the Install Complete screen appears (see 
Figure 4). 

Figure 4 Install Complete Screen
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Step 6 Click Done to quit the installer.

A shortcut for PUT is automatically created on the desktop.

Running PUT

Once you are done installing the PUT software, you are ready to start the backup 
process.

Step 1 Stop and disable Cisco Security Agent (CSA) and other antivirus software 
applications, if any, running on the CRS 5.x or Unified CCX 7.x nodes in the 
cluster.

Step 2 Make sure that all the nodes in the CRS or Unified CCX cluster are up and 
running.

Step 3 Double-click the PUT shortcut from the desktop to start the PUT. The CCX 
Pre-Upgrade Backup screen appears (see Figure 5).

Figure 5 CCX Pre-Upgrade Backup Screen
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Step 4 Click Next. The Pre-Backup Action Items screen appears listing the activities that 
you must accomplish prior to taking the backup (see Figure 6).

Figure 6 Pre-Backup Action Items Screen

Step 5 Click Accept if you agree to the listed termshave performed all the listed 
pre-backup activities. The Backup Location Details screen appears (see Figure 7).

Warning You must perform all the pre-backup activities listed on the Pre-Backup Action 
Items screen to proceed with the backup activity. If you have not performed any 
of the listed activities, quit the PUT immediately, perform the activity and then 
re-run the tool from the beginning.
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Figure 7 Backup Location Details Screen

Step 6 Enter the backup storage location details as follows:

a. SFTP Server: IP address or hostname of the SFTP server

b. SFTP Path: Path to the backup folder on the SFTP server

c. SFTP User Name: User name to access the SFTP server

d. SFTP Password: Password to access the SFTP server

Note Make sure that you have full read and write access to the SFTP server location 
where you intend to store the backup TAR file.

Step 7 Click Next. The CCX Backup Confirmation message appears prompting you that 
the tool has validated the SFTP location (see Figure 8). 
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Figure 8 CCX Backup Confirmation Message

Step 8 Click Yes to proceed. A warning message appears to ensure that sufficient space 
is available on the destination backup directory to store the backup TAR file (see 
Figure 9). Make sure you have enough space on the destination backup directory.

Figure 9 Warning Message for Free Space on Destination Directory

Step 9 Click OK to proceed with the backup process. The CCX Backup Progress screen 
appears (see Figure 10).
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Figure 10 CCX Backup Progress Screen

Once the backup process is complete, an information screen appears with the 
message that the backup operation completed successfully (see Figure 11).

Figure 11 CCX Backup Operation Completed Information Screen
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Step 10 Click OK and check the status on the CCX Backup Progress screen (see 
Figure 12).

Figure 12 CCX Backup Progress Screen

Step 11 Choose File > Verify Backup TAR on the Unified CCX Backup Progress screen 
to verify the TAR file details and the backup location. The Backup TAR Path 
Details screen appears (see Figure 13). 
Click Home if you want to verify the TAR file details and the backup location 
later. The Unified CCX Pre-Upgrade Backup screen appears (see Figure 5). 
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Figure 13 Backup TAR Path Details Screen

Step 12 Enter the details, such as IP address of the SFTP server, path to the backup TAR 
file, SFTP user name, and password in the respective fields.

Step 13 Click Check. The Unified CCX Backup TAR Info screen appears with the 
information about the backup that you have taken (see Figure 14).

Figure 14 Unified CCX Backup TAR Info Screen
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Step 14 View the backup TAR file information and click Close. 

Step 15 Choose File > Exit and then click Yes to quit the PUT.

Installation Phase
In the installation phase, you upgrade your existing CallManager or Unified CM 
and then install Unified CCX 8.0(2).

Step 1 After running the backup process using PUT and before installing Unified CCX 
8.0(2), you must upgrade the system running Unified CM to the latest compatible 
version using the software upgrade process and reboot the system to switch and 
activate the upgraded partition. For more information on the software upgrade 
process, see the Cisco Unified Communications Operating System Administration 
Guide for Cisco Unified CCX and Cisco Unified IP IVR, available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_installatio
n_and_configuration_guides_list.html

Unified CCX 8.0(2) works with the latest Unified CM versions for the Windows 
to Linux Upgrade to be successful. For information on supported upgrades, see 
the Software and Hardware Compatibility Guide for Cisco Unified CCX and 
Cisco Unified IP IVR available here.
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device_su
pport_tables_list.html

Step 2 Procure all the necessary Unified CCX 8.0(2) licenses and keep them handy 
before you start the restore process.

Step 3 Install Unified CCX 8.0(2) on a new system or reimage your existing system 
running CRS 5.0(2) or Unified CCX 7.0(1). For information on how to install 
Unified CCX 8.0(2) and the FAQs, see the Installation Guide for Cisco Unified 
CCX and Cisco Unified IP IVR available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products_suppo
rt_install_and_upgrade.html

Note It is important that you keep all the configuration parameters (provided during 
Unified CCX 8.0(2) installation) handy so that in case you need to re-install, the 
same Unified CCX 8.0(2) license can be re-used. For more details, see the 

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products_support_install_and_upgrade.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_installation_and_configuration_guides_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_device_support_tables_list.html
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Installing Cisco Unified CCX and Cisco Unified IP IVR available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_gu
ides_list.html

Restore Phase
In the restore phase, you retrieve the backed up data on the system installed with 
Unified CCX 8.0(2) (performed in the installation phase) and configure the initial 
setup.

After you complete the installation of Unified CCX 8.0(2), you must access the 
Cisco Unified CCX Administration Web interface through its Authentication page 
to restore the backed up data.

Start the Initial Setup Configuration on the Unified CCX 8.0(2) Server

Follow these steps to start restoring the backed up data and performing the initial 
setup procedure on the first node of the Unified CCX 8.0(2) cluster in a 
single-node setup or two-node setup:

Step 1 From any computer in the network that meets the client system requirements, 
enter the following URL in a Web browser, where servername is the host name or 
the IP address of the server on which you installed Unified CCX.

http://servername/

The product information page displays.

Step 2 Click Cisco Unified Contact Center Express. The Cisco Unified CCX 
Administration Authentication window appears.

Step 3 In the Cisco Unified CCX Administration Authentication window, enter the 
Administrator username and password that you created during installation. For 
details about the Administrator credentials you used during installation, see the 
Installation Guide for Cisco Unified CCX and Cisco Unified IP IVR available 
here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_gu
ides_list.html

Since the Administrator credentials are case-sensitive, make sure that you enter 
them exactly as created.

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_guides_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_guides_list.html
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Step 4 Click Login. The Cisco Unified CCX Administrator Setup window appears.

Step 5 Choose Upgrade from a previous UCCX release and then click Next. 
The Cisco Unified CCX Upgrade Setup window appears.

Step 6 Enter the Backup TAR location details as follows:

a. SFTP server IP Address/Hostname: IP address or hostname of the SFTP 
server on which backup is stored

b. Backup File Path: Path to the backup file on the SFTP server

c. User Name: User name to access the SFTP server

d. Password: Password to access the SFTP server

Note Make sure that you have at least read access to the SFTP server location from 
where you intend to restore the backup TAR file.

Step 7 Click Next. The License Information window appears.

Step 8 In the License Information window, click Browse to select the Unified CCX 
8.0(2) license file that you have procured, and then click Next to continue. 
The License Information window with validation information appears. 

For more details on licensing for an HA setup, see the Installation Guide for Cisco 
Unified CCX and Cisco Unified IP IVR available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_gu
ides_list.html

Step 9 Verify the validation information that appears in the License Information window 
and then click Next to continue. 
The Windows to Linux Upgrade Status window appears.

Read the instructions on the Windows to Linux Upgrade Status window and make 
sure that you have completed all the activities prior to starting the restore process. 

Step 10 Click Next to start the restore process. The Windows to Linux Upgrade in 
progress appears showing the status for components activation and the phases of 
the upgrade.

Step 11 After all the backed up configuration data and DB data are restored, the upgrade 
status displays the following message: 

Phase 1 completed successfully. Phase 2 started automatically in the 
background. Click Next to continue.

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_guides_list.html
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Phase 2 of the Windows to Linux Upgrade includes restoring the historical 
reporting (HR) data and recordings (audio files). Click Next.

Step 12 Click Next. A message window appears prompting you with the following 
message: 

You are about to be redirected to the Cisco Unified CCX Administration 
Authentication page. Do not reboot the server until all the phases of 
Upgrade are over.

Step 13 Click OK. The Cisco Unified CCX Administration window appears.

Step 14 Log in to the Cisco Unified CCX Administration using the same application user 
credentials of your CRS 5.0(2) or Unified CCX 7.0(1) server from where you have 
taken the backup.

Step 15 Before performing JTAPI Resync, check the status of upgrade by choosing Tools > 
Windows Upgrade. 

Step 16 Choose Subsystems > Cisco Unified CM Telephony > Cisco JTAPI Resync. 
The Cisco JTAPI Resync window appears showing the progress.

Step 17 After successful resync of Cisco JTAPI, a message prompts you to restart the 
Unified CCX Engine. 

Warning JTAPI resync can be performed at the same time when Phase 2 of upgrade is in 
progress, but Unified CCX Engine should NOT be restarted until the upgrade 
completes.

Step 18 If the call center needs to be operational after you finish installing the first node, 
then run the Unified CCX Desktop Client Configuration Tool on this node. You 
can do so by logging in to the web interface of the Cisco Unified CCX 
Administration and then choosing Tools > Plugin > Desktop Suite > Client 
Configuration Tool. Let the Unified CCX Desktop Client Configuration Tool run 
until it finishes. 
You have successfully upgraded to Unified CCX 8.0(2).



23
Upgrading to Cisco Unified Contact Center Express, Release 8.0(2)

  Upgrading to Unified CCX 8.0(2)

Note If calls are to be taken only after both nodes (in an HA setup) are up, then the 
Unified CCX Desktop Client Configuration Tool has to run only once, otherwise 
run it twice; once after the first node is up and one more time after the second node 
is up.

Post-Restore Phase

Here are the activities that you may need to perform on your system and the 
information you should be aware of after you successfully upgrade to Unified 
CCX 8.0(2):

• To build the second node in an HA setup after the upgrade is complete on the 
first node, do the following:

a. Add the second node information to the first node using the Web 
interface of the Cisco Unified CCX 8.0(2) Administration before you 
install the second node. 

For more information on how to configure the second node on the first 
node for HA, see the Installation Guide for Cisco Unified CCX and Cisco 
Unified IP IVR available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_install
ation_guides_list.html

Caution In case of HA setup, you should start installing the second node only after the 
upgrade on first node is completed successfully to avoid data conflicts.

b. Install the second node and log in to the Cisco Unified CCX 8.0(2) 
Administration Web interface to perform the Add to Cluster operation 
(through LAN or WAN) so you can add the second node to the cluster.

For more information on how to install the second node for HA and how 
to perform the Add to Cluster operation, see the Installation Guide for 
Cisco Unified CCX and Cisco Unified IP IVR available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_install
ation_guides_list.html

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_guides_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_guides_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_guides_list.html
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• After successful upgrade, the Preview Outbound seat count will not be carried 
forward in case of an upgrade from CRS 5.0(2) or Unified CCX 7.0(1) to 
Unified CCX 8.0(2). By default, the Preview Outbound seat count will be 
initialized with the maximum supported value for the given hardware type. 
You need to manually modify the seat count in the System Parameters 
Configuration page of the Unified CCX Administration according to the 
usage. See Table 1 for the maximum Preview Outbound seat count.

Table 1 Preview Outbound Seat Count Hardware Limit

• After successful upgrade, HTTP trigger will work on port 9080 in Unified 
CCX 8.0(1). Also applications using the HTTP port 8080 should be changed 
to 9080.

• If IP Address of the existing server is changed during upgrade, change all 
parameters in the applications referring to the IP Address to match the new 
IP Address. For more details, refer to the Cisco Desktop Administrator User 
Guide for CAD available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_user_g
uide_list.html

• To start using the Wallboard application on Unified CCX 8.0(1), see the 
Administration Guide for Cisco Unified CCX and Cisco Unified IP IVR 
available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_install
ation_and_configuration_guides_list.html

• Manually upgrade all third party sub-systems like ASR/TTS to versions 
compatible with Unified CCX 8.0(2) since these are not automatically 
upgraded.

Hardware Type Maximum Preview Outbound Seat Count

Cisco MCS-7845 300

Cisco MCS-7835 75

Cisco MCS-7825 75

Cisco MCS-7816 50

Others 300

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_installation_and_configuration_guides_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_user_guide_list.html
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• Some ports, such as RMI, RmCm, and TCP are upgraded to default Unified 
CCX 8.0(2) ports. For more details about these ports in Unified CCX 8.0(2), 
refer to the Port Utilization Guide for Cisco Unified CCX and Cisco Unified 
IP IVR available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_install
ation_and_configuration_guides_list.html

• Manually add the e-mail templates (configured on Cisco Desktop 
Administrator) on the Unified CCX 8.0(2) after the upgrade since these are 
not automatically upgraded.

• If you have set the default password in Cisco Desktop administrator to blank 
in Unified CCX 7.0(1), the default password changes to “crsadmin” after your 
system is upgraded to Unified CCX 8.0(2).

• If reason code '0' has been defined in Unified CCX 7.0 (1), it automatically 
changes to 1001 when upgraded to Unified CCX 8.0(2).

• After you complete upgrading the second node, you must run the Unified 
CCX Desktop Client Configuration Tool (by logging in to the web interface 
of the Cisco Unified CCX Administration and then choosing Tools > Plugin 
> Desktop Suite > Client Configuration Tool) to create 
correctly-configured MSI files for the client applications. The Automated 
Update feature uses these MSI files to update the client desktops the next time 
users launch a CAD application. 

• To support installation of Express Gateway on your upgraded Unified CCX 
8.0(2) system, modify the existing RmCm port 42027 to the new RmCm port 
12028.

Examining Log Files
If you encounter problems with the upgrade, you may be able to examine the 
following log files:

• Backup operation log files at C:\W1Log<time stamp>.zip on the CRS 5.0(2) 
or Unified CCX 7.0(1) server.

• Restore operation log files after downloading from the RTMT and unzipping 
them. To download the log files from RTMT, do the following:

a. Log in to RTMT and then choose Trace and log central > Collect files.

b. Choose the Cisco Unified Cluster View daemon component.

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_installation_and_configuration_guides_list.html
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c. On the next page choose Install and Upgrade logs.

d. Select the time range when upgrade was performed by choosing CVD > 
Install/Upgrade Logs. 

For more details, refer to the Cisco Unified Real Time Monitoring Tool 
Administration Guide for Cisco Unified CCX and Cisco Unified IP IVR 
available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_in
stallation_and_configuration_guides_list.html

Obtain Additional Support and Documentation
For information on obtaining support, obtaining additional documentation, 
providing documentation feedback, security guidelines, and also suggested 
aliases and general Cisco documents, see the monthly What's New in Cisco 
Product Documentation, which also lists all new and revised Cisco technical 
documentation, at: 

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html 

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple 
Syndication (RSS) feed and set content to be delivered directly to your desktop using 
a reader application. The RSS feeds are a free service and Cisco currently supports 
RSS version 2.0.

Documentation Feedback
You can provide comments about this document by sending an email to the 
following address:

ccbu_docfeedback@cisco.com

We appreciate your comments.

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_installation_and_configuration_guides_list.html
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
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